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Chapter 1: Introduction to eCare

Welcome to eCare!

The eCare system allows Support Agents to interact with customers, in real time, 
to efficiently identify and resolve technical-support and customer-service issues. 
As a Support Agent, you can use eCare’s remote-access services to steer your cus-
tomers and fellow employees to the Web pages and information they need, send 
them files and applications, and even observe or control their computers to help 
diagnose and resolve their problems. You can provide fast and efficient customer 
service and troubleshooting services for remote employees as if they were work-
ing in the same building.

Preparing to Use eCare

Before you can use eCare to support your employees and customers, you must re-
ceive a user name and password from your organization’s eCare administrator. 
You also must make sure that your computer meets the minimum system require-
ments and security permissions to use eCare and connect to remote computers.

System Requirements

To sign in to the eCare system and connect to remote computers, you must have 
the following system software and security settings.

eCare System Requirements

Windows Macintosh

Operating System Windows 98 Second Edition, 
Windows 2000, Windows Me, Windows XP, 
Windows 2003

Mac OS X version 10.4.0 or greater
eCare 4.5 runs on both PowerPC and Intel-
based Macintosh computers

Web Browser Internet Explorer 6.0 – 7.0 Safari 1.3 or greater 
| 5
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Note: Internet Explorer 5.5 and Mac OS X 10.3.9 are still supported for your eCare 
customers. However, as a Support Agent, you must use more current versions. 

If your organization uses a proxy server to connect to the Internet, your computer 
must also use the correct proxy settings. Your system administrator will notify you 
if any settings need adjustment.

Browser Security and Privacy Settings

Settings for Windows Computers 

To prevent Internet Explorer settings from interfering with eCare communications, 
you must set your eCare server as a Internet Explorer Trusted Site. For example, if 
the URL for your eCare service is 

http://help.ecare.com/support 

add http://help.ecare.com to your list of Trusted Sites.

The default Trusted Site settings allow for normal eCare operations. If you wish to 
use a Custom Security setting for Trusted Sites, however, you may set the follow-
ing individual options.

The following settings are accessible from the Security tab in the Internet Options 
dialog box. (To open the Internet Options dialog box, click the Tools menu and 
choose Internet Options.) Select the Internet content zone and click the Custom 
Level button. Make sure the following options are set correctly.

• Download Signed ActiveX Controls—Set to Prompt.
• Run ActiveX Controls and Plug-ins—Set to Enable.

Browser Settings Java, JavaScript, and ActiveX enabled
Medium security or lower
Cookies must be allowed
(see “Browser Security and Privacy Set-
tings” below)

Plug-ins and JavaScript enabled
Cookies must be allowed
(see “Browser Security and Privacy Set-
tings” below)

Permissions ActiveX control installation privileges (on 
Windows NT-based computers)

Administrator privileges on the local 
computer

Pop-Up Blockers Pop-up blockers must be disabled Pop-up blockers must be disabled

eCare System Requirements (continued)

Windows Macintosh
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• Use Pop-Up Blocker—Set to Disable (Windows XP only). 
• Active Scripting—Set to Enable.

Cookie settings are accessible from the Privacy tab in the Internet Options dialog 
box. In the Settings area, make sure the slider is set to Medium High or below. 

Settings for Macintosh Computers 

The following settings are located on the Security tab in the Safari Preferences di-
alog box. Make sure the following options are set correctly.

• Under Web Content, make sure the Enable Plug-ins and Enable JavaScript op-
tions are selected.

• Under Web Content, make sure the Block Pop-Up Windows option is cleared.

• Under Accept Cookies, select Always or Only From Sites You Navigate To.

If you need to adjust your browser settings, see your Safari documentation for 
more information.

Pop-Up Blockers 

All pop-up blocking software for your browser must be turned off before you can 
use eCare. This includes the pop-up blockers that are built in to Internet Explorer 
and Safari, as well as third-party blocking software for all platforms. 

Downloading and Installing the eCare Remote-

Control Component

Before you can use eCare’s screen-sharing services—Control, Observe, Show My 
Screen, and Give User Control—you will need to install the eCare remote-control 
component, which is a control that enables your computer to use these services. 
Windows computers use the eCare ActiveX control, while Macintosh computers 
use the eCare plugin. The following sections discuss downloading and installing 
the eCare remote-control component on your computer.

The Windows eCare ActiveX Control

In most eCare installations, the first time you sign in t0 eCare using a Windows 
computer, you will receive a window asking you to download and install the eCare 
ActiveX control. (Your customers who access eCare using Windows computers will 
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receive the same message. Macintosh users will be prompted to download the 
eCare plugin as described on page 8.)

Note: Depending on your company’s eCare setup, your eCare administrator may 
have pre-installed the ActiveX control on your computer, or you may be prompted 
to download it at a different time. See your administrator if you have questions.

To install the ActiveX control, click the Accept button. Then click Yes in the Secu-
rity Warning dialog box. 

• On most operating systems, the ActiveX control will download and install 
automatically. 

• On Windows XP computers, the Installing Browser Add-On window appears. 
Right-click the yellow ActiveX warning bar and select Install ActiveX Control to 
begin installing the eCare remote-control component. When a window ap-
pears, asking if you want to install the software, click the Install button.

Note: You will need to click the Install button twice to install both the eCare 
remote-control component and the eCare reconnect component.

The ActiveX control is named CobAgent4 Class. It is installed in the 
WINNT/Downloaded Program Files or WINDOWS/Downloaded Program Files 
folder. When the installation is complete, the trouble-ticket queue appears.

Note: Periodically, Motorola releases upgrades to the eCare system. If you open 
the eCare Web site and your system detects an upgraded ActiveX control, it will 
automatically prompt you to update to the new version.

The Macintosh eCare Plugin

In most eCare installations, the first time you access the eCare site using a Macin-
tosh computer, you will receive a dialog box asking you to download and install 
the eCare plugin. (Your customers who access eCare using Macintosh computers 
will receive the same message. Windows users will be prompted to download the 
eCare ActiveX control as described on page 7.)

Note: Depending on your company’s eCare setup, your administrator may have 
pre-installed the eCare plugin on your computer, or you may be prompted to 
download it at a different time. See your eCare administrator if you have any 
questions.

Click the link to download the eCare plugin. It will be downloaded as a disk image 
and opened automatically. 
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To install the browser plugin, double-click the Netopia RC Installer  file. (Depend-
ing on your Mac OS X settings, it may run automatically.) A dialog box appears, in-
dicating that the browser plugin will be installed. Click Yes. 

Installation then proceeds automatically. When installation is complete, you will 
be notified. To complete the plugin installation, shut down and restart Safari. You 
must perform the restart to complete the plugin installation. Then return to the 
eCare URL and sign in.

Note: Periodically, Motorola releases upgrades to the eCare system. If you open 
the eCare Web site and your system detects an upgraded plugin, it will automati-
cally prompt you to update to the new version.

Accessing the eCare Service

To access the eCare service, open your browser and go to the URL provided by Mo-
torola or your eCare administrator. In most cases, this URL will be in the form

http://<ecare-server>/<service-name>/agent 

Sign in to the eCare system with the user name and password you were assigned.

When you load the main eCare page for the first time, you may automatically be 
prompted to download and install the eCare ActiveX control or the eCare plugin. 
See the following section, “Downloading and Installing the eCare Remote-Control 
Component.”

Note: Your administrator may have pre-installed the ActiveX control or plugin on 
your computer, or you may be prompted to download it at a different time. See 
your eCare administrator if you have any questions.

When you sign in to eCare, the main trouble-ticket queue appears. 
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Note: The eCare interface is highly customizable. Your eCare administrator may 
have set up your eCare service with an appearance that is dramatically different 
from the images that appear in this document. However, the controls and their 
names will remain very similar. 

From this page you may select a customer to assist (see “Selecting a Ticket” on 
page 15) or send an email invitation to a customer who has not entered a trouble 
ticket (see “Sending an Email Invitation” on page 17). You also have the option to 
change your eCare password. See “Changing Your Password” on page 19.

Email Notification

If your eCare system is set up with email notification, and your eCare administra-
tor has specified your email address in the email-notification configuration, the 
eCare server will send you an email message every time a customer submits a 
new trouble ticket.

When you receive a notification email, open the trouble-ticket queue and select 
the customer’s trouble ticket. (If the trouble ticket has already been selected by 
another eCare Support Agent, its status will indicate Servicing.)



Chapter 2: The Customer Experience

When your customer needs assistance, the first step is to fill out a trouble ticket. 
In most cases, the customer will fill out the trouble ticket. However, the Send Invi-
tation service allows you to enter a trouble ticket on the customer’s behalf. 

Submitting a Trouble Ticket

When customers need technical support or customer service, they will visit your 
organization’s Web site and click a Web link to open the trouble-ticket form. 

Note: You may also email an eCare link to the customer if, for example, you are 
already providing telephone support. The customer can click the link to enter the 
queue automatically. See “Sending an Email Invitation” on page 17.

The appearance of this window may vary depending on your eCare installation. 
Your eCare administrator may also configure it to display a special message to 
the customer, such as network status information or special offers.

When the customer fills in the requested information and clicks Submit, a trouble 
ticket is created in the eCare ticket queue. The eCare session window opens on 
the customer’s desktop, asking them to wait for the next available Support Agent 
and showing their place in line. (The customer may also be asked to fill out a sur-
vey before joining the queue. See the following section, “Filling Out a Customer 
Survey.”)

The customer must keep the eCare session window open to remain in the queue. 

Filling Out a Customer Survey

Your eCare administrator may configure your eCare service to present a survey af-
ter the customer fills out the ticket submission form or after you resolve their 
trouble ticket (or both). After the customer fills out the survey and clicks Submit, 
the eCare session window opens. 
| 11
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Responding to an Email Invitation

In some situations, such as when you are assisting a customer on the phone and 
need to begin an eCare session, it may be easier for you to fill out the trouble-
ticket form on the customer’s behalf. You can use the Send Invitation service to 
open the trouble ticket and email it to the customer. (Creating the invitation is dis-
cussed in “Sending an Email Invitation” on page 17.) 

When you submit the email invitation, eCare sends an email message to the 
email address you specify in the invitation. 

The email message contains a unique URL, which includes a preassigned trouble-
ticket ID number. When the customer loads the URL in their Web browser, the 
trouble ticket is submitted to the queue automatically. The eCare session window 
is displayed, displaying the trouble-ticket number and asking the customer to 
wait for the next available Support Agent.                                                      

When the customer enters the ticket queue, you will select the ticket and proceed 
normally with the eCare session as described throughout this document. 

Note: The customer can use the invitation URL only one time, after which it is no 
longer valid. (The link will still load the eCare service, but the customer will be 
required to submit a new trouble ticket.) In addition, the URL will expire after 50 
minutes. (Your eCare administrator can change the default expiration period.) If 
the customer attempts to reuse the URL, or to use it after it expires, eCare will 
direct them to submit a new trouble ticket.

Reconnecting After Reboot

During an eCare session, you may make changes to the customer’s computer that 
require the computer to reboot. If the customer is using Internet Explorer for Win-
dows, you will be able to force the computer to reboot by using the Reboot Re-
mote System service, described in “Reboot Remote System” on page 29. 

When you send the reboot order, eCare displays the Activate dialog box on the 
customer’s computer. 

• If the customer clicks Yes, eCare executes the reboot.

• If the customer clicks No, the eCare session transcript will display a message 
that the request was denied. Be sure to explain what you are doing. 
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When the reboot is complete, the customer’s Web browser will automatically 
open and load a unique eCare URL, which returns the customer to the trouble-
ticket queue with the same ticket ID as before. The eCare session window is dis-
played, displaying the trouble-ticket number and asking the customer to wait for 
the next available Support Agent.

When the customer reenters the ticket queue, you will select the ticket and pro-
ceed normally with the eCare session as described throughout this document. 
The transcript area in the eCare session window will display the full session tran-
script, including the portion of the session that took place before the reboot.

Reconnecting After Session Interruption

During an eCare session, it may occur that your connection with the customer 
fails. (For example, the customer’s network connection may be interrupted.) The 
eCare reconnect component allows eCare to retain the customer’s trouble-ticket 
number and session history when the customer reconnects. 

When you accept an eCare trouble ticket, and the eCare reconnect component is 
enabled on your eCare service, the Activate dialog box opens on the customer’s 
screen, asking them to activate the reconnect component. 

If the customer clicks Yes, eCare saves a unique URL as a shortcut on the cus-
tomer’s desktop. If the eCare session is interrupted, the customer can double-
click the shortcut to return to the trouble-ticket queue with the same ticket ID as 
before. The eCare session window is displayed, displaying the trouble-ticket 
number and asking the customer to wait for the next available Support Agent.

When the customer reenters the ticket queue, you will select the ticket and pro-
ceed normally with the eCare session as described throughout this document. 
The transcript area in the eCare session window will display the full session 
transcript, including events that took place before the interruption.

Note: The customer can use the reconnection shortcut only one time, after which 
the URL is no longer valid. By default, the URL will expire after 50 minutes. Your 
eCare administrator can configure the expiration period.



Chapter 3: Working with eCare

When you sign in to the eCare system, the eCare session window appears.

When you first sign in to the eCare system, both the Active Tickets and My Tickets 
areas display the message No Active Tickets. The Waiting area displays the cur-
rent trouble-ticket queue. (You can use the View menu to sort the queue by a 
specified criterion.)

When you select the first customer to assist, the Active Tickets area will display 
your activity with the customer. The My Tickets area will list this customer and, 
later, any additional customers whose trouble tickets you also accept. Click a cus-
tomer’s name in the My Tickets list to switch your Active Ticket to that customer’s 
trouble ticket.

If your eCare system is set up with email notification, and your email address is 
included in the notification list, you will receive an email message each time a 
| 14
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new trouble ticket is created. (See “Email Notification” on page 10 for more infor-
mation.) You do not need to be signed in to the eCare system to receive email 
notifications.

Selecting a Ticket

When you view the trouble-ticket queue, you have several options. You may 

• Select a trouble ticket in the Waiting area and move your mouse over the 
Ticket menu to display a list of options. You may accept or delete the trouble 
ticket. 

Double-click a trouble ticket in the Waiting area to accept the request and 
begin helping the customer.

Note: The Delete Ticket option is available only if your Support Agent profile 
has been assigned this privilege.

• Move your mouse over the Ticket menu and choose Send Invitation to open a 
trouble ticket and email it to the customer you specify. See “Sending an 
Email Invitation” on page 17 for more information. 

• Move your mouse over the View menu to display a list of options for sorting 
the trouble-ticket queue. 

Choose View All Tickets to open a new window that lists the active trouble 
tickets in more detail, including a summary of the customer’s support issue.
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Using the View All Tickets Window

The View All Tickets window displays all trouble tickets in your queue and in-
cludes more detail than is shown in the Waiting area. 

• Click a customer’s email address in the Email column to send the customer 
an email without opening the trouble ticket. A blank email message, ad-
dressed to the customer, will open in your default email client.

• Click the Delete button to remove the trouble ticket from the queue without 
opening the trouble ticket or assisting the customer. (The Delete button ap-
pears only if your Support Agent profile has been assigned this privilege.) 

Accepting a Request in the Queue

To accept a trouble ticket and begin helping the customer, select a trouble ticket 
in the Waiting area. Move your mouse over the Ticket menu and choose Accept 
Ticket. Or double-click the desired trouble ticket. 

You may choose the first request in the queue whose status is Waiting or Esca-
lated, use the View All Tickets window to review the ticket summaries for an issue 
that relates to your area of expertise, or select a specific customer to assist.

When you accept a request in the trouble-ticket queue, you are connected to the 
customer. The Active Tickets area changes to display the session transcript panel, 
and a number of control menus appear above and below the transcript. See “In-
teracting with the Customer” on page 20.
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Deleting a Request from the Queue

To delete a request from the queue, select the ticket and move your mouse over 
the Ticket menu. Then select Delete Ticket. 

Remember that the Delete Ticket option is available only if your Support Agent 
profile has been assigned this privilege.

Resolved requests are deleted from the queue automatically.

Sending an Email Invitation

In some situations, such as when you are assisting a customer on the phone and 
need to begin an eCare session, it may be easier for you to fill out the trouble-
ticket form on the customer’s behalf. You can use the Send Invitation service to 
open the trouble ticket and email it to the customer. 

You can fill out the trouble ticket as you speak to the customer or by copying their 
information from another customer-management application. When you submit 
the email invitation, eCare sends an email message to the email address you 
specify in the invitation. 

The email message contains a unique URL, which includes a preassigned trouble-
ticket ID number. When the customer loads the URL in their Web browser, the 
trouble ticket is submitted to the queue automatically. 
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To send an email invitation

1. Move your mouse over the Ticket menu and choose Send Invitation.

2. Enter the customer’s information in the appropriate fields. (Note that only the 
email address is required.) Be sure to double-check the email address; if you 
enter the address incorrectly, the customer will not receive the invitation. 

3. Click Submit to send the email message to the email address you specified. 

When the customer receives the email, loads the URL in their Web browser, and 
enters the trouble-ticket queue, you will select the ticket and proceed normally 
with the eCare session as described throughout this document. 

Note: The customer can use the invitation URL only one time, after which it is no 
longer valid. By default, the URL will expire after 50 minutes. Your eCare adminis-
trator can configure the expiration period.
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Changing Your Password

To change your eCare password, click your name at the upper-right corner of the 
eCare session window.

On the Change Password screen, enter your new password in the New Password 
and Confirm Password fields. Then click Submit. The password must be at least 5 
characters in length (the maximum possible length is 200 characters), and it can 
contain any alphanumeric characters. You cannot save the new password until 
the New Password and Confirm Password boxes match exactly.
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Interacting with the Customer

When you accept a request in the trouble-ticket queue, you are connected to the 
customer. The Active Tickets area changes to display the session transcript panel, 
and a number of control menus appear above and below the transcript. 

When you accept the trouble ticket and your eCare session begins, the cus-
tomer’s eCare window, which displayed their place in line, changes to an active 
session window. 
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The Active Tickets Area

In the middle of the Active Tickets area, the session transcript panel displays the 
activity that occurs during your eCare session. At the beginning of the transcript, 
eCare displays the ticket number and the customer’s contact and trouble-ticket 
information. As you work with the customer, the session transcript will display a 
record of your conversation and the eCare services you use. 

Note: If the customer reconnected to eCare after a reboot or a session interrup-
tion, the transcript from the previous session will appear in the transcript area. 

The text-chat area appears below the session transcript panel. In most cases, you 
will begin your eCare session by chatting with the customer about their support 
issue. Enter text in the text-chat area and click Send to begin the conversation. 

The Control Menus

At the top of the eCare session window, above the session transcript panel, are 
the Ticket menu and up to three service menus: Share, Files, and Tools. Below the 
session transcript panel are up to three additional menus: Messages, Push URL, 
and Reference. 

The Ticket Menu

The Ticket menu includes three options: Resolve, Escalate, and Request 
Transcript. 

• You will use the Resolve and Escalate options to close the eCare session win-
dow when you are finished working with the customer (see “Ending a Sup-
port Session” on page 32). 

• At any time during the eCare session, you may select the Request Transcript 
option. When the session is complete, the eCare server will email you a ses-
sion transcript. (The Request Transcript option is not available if the eCare 
administrator did not enter your email address in your Support Agent profile.) 

Note: If the customer entered an email address in the trouble ticket, the 
Email Transcript link will appear at the top right of their eCare session win-
dow. You may wish to inform the customer that they can request the tran-
script to save for future reference. Remind the customer that the transcript 
will be sent when the session is complete; it will not be sent immediately. 
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The Service Menus

The service menus list options that allow you to activate the different eCare ser-
vices. Each eCare service enables you to interact with the customer (or the cus-
tomer’s computer) in a different way. 

However, in certain cases, some eCare services may not be available. 

• The services you may use depend on your eCare installation and the privi-
leges that have been assigned to your Support Agent account. For example, if 
you are using an account with “standard agent” privileges, all of the screen-
sharing features are disabled. To use screen-sharing services, you must be 
assigned “premium agent” privileges. Contact your eCare administrator if 
you believe your service privileges are incorrect.

• Your eCare administrator may configure your eCare installation to remove 
certain services entirely. In this situation, the associated menus and options 
will not appear in the eCare session window. 

• If the customer is using a browser that does not fully support eCare, or if they 
did not download the eCare remote-control component, the screen-sharing 
options may be disabled. 

See “eCare Services and the Service Menus” on page 23 for information about 
service menus and the options they contain.

Chatting with the Customer

When you select a trouble ticket and begin an eCare session, the text-chat fea-
ture is available automatically. You will begin most of your eCare sessions by 
chatting with the customer to better understand the problem the customer is hav-
ing and the type of service that is needed. 

Enter text in the text-chat area and click Send to send the message to the cus-
tomer. Or select a message from the Messages menu, which displays a custom-
ized list of standard chat phrases you can select and send. (The Messages menu 
will not appear if your eCare administrator has not configured any chat phrases. 
See your eCare administrator for more information about this option.)

Once you have discussed the problem with the customer, use the service menus 
above the session transcript panel to select and launch the service you need to 
assist the customer. See the following section, “eCare Services and the Service 
Menus,” for more information on each service. 
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Remember that the actions you may perform depend on your eCare installation 
and the service privileges that have been assigned to your Support Agent profile. 

Each time you launch a service or connection with the remote computer, a record 
of the action you took appears in the session transcript panel in your eCare ses-
sion window. The transcript also appears in the customer’s session window. 

eCare Services and the Service Menus 

When chatting with the customer isn’t enough to resolve their problem, you can 
use additional eCare services to assist them further. Use the service menus above 
the session transcript panel to select and launch the service you need to assist 
the customer. Depending on your eCare installation, you may be able to 

• Use services from the Share menu to directly view or control the customer’s 
computer or allow the customer to control or view your computer. See the fol-
lowing section, “The Share Menu.”

• Use services from the File menu to send a file to the customer’s computer or 
request a file from the customer. See “The File Menu” on page 26.

• Use services from the Tools menu to generate a “snapshot” of the hardware 
and software on the remote computer or reboot the remote computer. See 
“The Tools Menu” on page 27. 

• Use options from the Messages, Push URL, and Reference menus to send a 
pre-configured chat message, push a URL to the customer’s browser, or load 
a Web page on your own computer that may help you assist the customer. 
See “The Messages, Push URL, and Reference Menus” on page 30.

The Share Menu 

With the services on the Share menu, you may directly view or control the cus-
tomer’s computer or allow the customer to control or view your computer. These 
services are collectively known as screen-sharing services. The services you may 
use are discussed in the following sections.

Depending on your eCare installation, the first time you launch one of the ser-
vices on the Share menu, you or the customer (or both) may be prompted to 
download and install the eCare remote-control component. Your eCare adminis-
trator can provide this information. Be sure to use the text-chat window to let the 
customer know what to expect. See “Downloading and Installing the eCare Re-
mote-Control Component” on page 7 for details.
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The Share menu will not appear if your eCare installation does not support it, or if 
screen-sharing privileges are not granted to your Support Agent account. If the 
current eCare session will not support screen-sharing—for example, if the cus-
tomer is not using a supported Web browser— the Share menu will appear, but its 
options will be disabled. 

If the Share menu’s options are disabled, make sure that your customer is using a 
supported Web browser and confirm that they downloaded the eCare remote-con-
trol component. (See “System Requirements” on page 5 for a list of supported 
browsers and their associated settings.) If your customer is not using a supported 
browser, you may still be able to use the text-chat feature. If you need to use the 
remote-control services, inform the customer and ask them to return to eCare with 
a supported browser. 

Using the Control Service 

The Control service grants you, as the Support Agent, direct control of the remote 
computer. Often this is the quickest and most efficient way to change settings, 
install software, and configure a remote system. However, you can reassure the 
customer that eCare leaves the ultimate control in their hands. The customer al-
ways has first-priority control over their mouse and keyboard, so they can over-
ride any mouse or keyboard actions you take. They can even shut down the 
remote control session altogether.

Open the Share menu and choose Control to take control of the remote computer 
and use your mouse and keyboard to remotely control the system. The Ask for 
Permission dialog box will appear on the customer’s screen, prompting them to 
allow or deny the connection. (See “Approving Screen-Sharing Sessions” on 
page 26 for details.) Use the text-chat window to let the customer know what to 
expect. The customer must click Allow to complete the connection. 

The customer can end the session at any time by clicking Stop in the Host Con-
trols window, which appears when the screen-sharing session is established.

Using the Observe Service 

The Observe service allows you to view the remote computer’s desktop while the 
customer maintains control over the machine. With Observe, you can watch the 
customer replicate the problem for you. You can see where the customer is having 
trouble and use the text-chat window, or one of the other services, to solve the 
problem. The Observe service allows you to watch the remote computer but as-
sures the customer that you cannot make any changes to their computer.
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Open the Share menu and choose Observe to start the screen-sharing service. 
The Ask for Permission dialog box will appear on the customer’s screen, prompt-
ing them to allow or deny the connection. (See “Approving Screen-Sharing Ses-
sions” on page 26 for details.) Use the text-chat window to let the customer know 
what to expect. The customer must click Allow to complete the connection.

The customer can end the session at any time by clicking Stop in the Host Con-
trols window, which appears when the screen-sharing session is established.

Using the Show My Screen Service 

The Show My Screen service allows a customer to view your desktop while you 
maintain control over your machine. With Show My Screen, your customer can 
watch you work as you demonstrate procedures or point out problem areas. Show 
My Screen allows customers to watch your system but assures you that they can-
not make any changes to your computer.

Open the Share menu and choose Show My Screen to allow the customer to view 
your desktop. The Ask for Permission dialog box will appear on your screen, 
prompting you to allow or deny the connection. (See “Approving Screen-Sharing 
Sessions” on page 26 for details.) Meanwhile, the Waiting for Permission dialog 
box appears on the customer’s computer, indicating that the connection is being 
established. Click Allow to complete the connection.

You can end the session at any time by clicking Stop in the Host Controls window, 
which appears when the screen-sharing session is established.

Using the Give User Control Service 

The Give User Control service is similar to Share My View, but the customer will 
have direct control of your machine. You can use the Give User Control service to 
display your desktop on the remote computer and allow the customer to control 
your computer for instructional or training purposes. However, eCare leaves the 
ultimate control in your hands. You always have first-priority control over the 
mouse and keyboard, so you can override any mouse or keyboard actions the 
customer takes.

Open the Share menu and choose Give User Control to allow the customer to take 
control of your computer and use their mouse and keyboard to remotely control 
your system. The Ask for Permission dialog box will appear on your screen, 
prompting you to allow or deny the connection. (See “Approving Screen-Sharing 
Sessions” on page 26 for details.) Meanwhile, the Waiting for Permission dialog 
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box appears on the customer’s computer, indicating that the connection is being 
established. Click Allow to complete the connection.

You can end the session at any time by clicking Stop in the Host Controls window, 
which appears when the screen-sharing session is established.

Setting Color Depth

In addition to activating the screen-sharing services, options on the Share menu 
allow you to specify the color depth of a screen-sharing session. Before you 
launch a screen-sharing session, you may wish to select a color depth from the 
options listed at the bottom of the Share menu. Fewer colors allow for faster 
screen-sharing. 

The color-depth controls affect screen-sharing sessions in both directions: when 
you view the customer’s computer and when the customer views your computer. 

Note: You must set the color depth before you start a screen-sharing session. You 
cannot change the color depth of an active session. 

Approving Screen-Sharing Sessions

Before you can use the Control or Observe service to access the remote computer, 
the customer must approve it. Similarly, when you use the Show My Screen or 
Give User Control service to ask a customer to view your computer, you will need 
to grant permission before the connection can be completed.

When you choose the Control or Observe menu option, the Ask for Permission di-
alog box appears on the customer’s screen, requesting permission to perform the 
action you requested. When an incoming connection to your computer begins 
with the Show My Screen or Give User Control service, the same Ask for 
Permission dialog box appears on your screen. If permission is denied, the con-
nection will not be completed.

When you launch any screen-sharing session, use the text-chat window to explain 
to the customer what is happening. 

The File Menu 

With the services on the File menu, you can send a file to the customer’s com-
puter or request a file from the customer. 
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Using the Send a File Service

With the Send a File service, you can upload a file from your computer to the 
eCare server, allowing the customer to download the file. Use the Send a File ser-
vice to send customers the latest version of your software or documentation, up-
dated product information, or confidential files that you cannot post to your Web 
site.

To send a file to the customer, open the File menu and choose Send a File. In the 
Send a File window, click the Browse button and locate the file you wish to send. 
Then click Send File.

The file is uploaded to the eCare server. A window appears on the remote com-
puter, asking the customer to accept the download. The customer must click Al-
low Download. Then, the File Download window allows the customer to save the 
file to the local computer. Be sure to tell the customer to click the Save button, 
rather than the Open button.

The maximum file size permitted by the Send a File service is set when your eCare 
configuration is created. Your administrator will tell you what the file-size limit is 
in your eCare installation.

Using the Request a File Service

With the Request a File service, you can allow the customer to upload a file to the 
eCare server. For example, you may want the customer to send you log files or 
other documents that can help you diagnose their support issue. 

To request a file from the customer, open the File menu and choose Request a 
File. The Send a File window opens on the customer’s computer. The customer 
must click the Browse button, locate the file they wish to send, and click Send 
File.

The file is uploaded to the eCare server, and a window appears on your computer, 
allowing you to save the file to your computer. Be sure to click the Save button, 
rather than the Open button.

The maximum file size permitted by the Request File service is set when your 
eCare configuration is created. Your administrator will tell you what the file-size 
limit is in your eCare installation. 

The Tools Menu

With the services on the Tools menu, you may generate a “snapshot” of the re-
mote computer and its settings, allowing you to access information that may 
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assist you in solving the customer’s problem. You may also reboot the remote 
computer. 

Using the System Information Service

To generate a system report for the customer’s computer, open the Tools menu 
and choose System Information. 

The System Information service gathers information about the remote computer 
that may assist you in solving the customer’s problem. With one click, you can re-
trieve targeted information on the operating environment of the remote computer. 
For example, the report includes the remote computer’s hardware profile and a 
list of installed software, which may enable you to resolve conflicts or determine 
the likely cause of errors. In addition, you’ll receive a complete list of the pro-
cesses running on the remote computer and a summary of the proxy and security 
settings in the customer’s Web browser. Erroneous settings are a common cause 
of connection failures. 

When you start the System Information service, an Ask for Permission dialog box 
appears on the customer’s screen, requesting permission to examine the com-
puter. The customer must click Allow to enable the session to proceed.

Once the examination is complete, a new browser window opens and displays 
the System Information report. (This process may take a few moments.) For de-
tailed information about the System Information report, see “Appendix A: Using 
the System Information Service” on page 33.

When you are finished with the System Information report, close the window by 
clicking the close button in the upper-right corner of the window. Or, when you re-
solve or escalate the trouble ticket, the window will close automatically. 

If your eCare Administrator has configured eCare to automatically save data from 
the System Information report, the raw XML on which the report is based is ar-
chived for audit and diagnostic purposes. To view the data (which will be dis-
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played in raw XML format, without special processing), click the link in the 
session transcript line “The system analysis data can be seen by clicking here.” 
The customer may also use this link to view their computer’s data.

If you need to reopen the report in its original format, however—or if eCare is not 
configured to save reports and you need to review the report data—you must use 
the System Information service again.

Reboot Remote System 

If you have made changes to the customer’s computer that require the computer 
to reboot, use the Reboot Remote System service. Before you reboot the remote 
computer, be sure to explain to the customer what to expect. 

Note: The Reboot Remote System service is supported only if the customer’s 
computer is running Windows 2000 or Windows XP. It is not supported on Macin-
tosh computers. 

1. To reboot the customer’s computer, open the Tools menu and choose Reboot 
Remote System.

2. On the customer’s computer, the Activate dialog box appears. 

• If the customer clicks Yes, eCare writes a unique key to the customer’s 
Windows registry and executes the reboot.

• If the customer clicks No, the eCare session transcript will display a mes-
sage that the request was denied. Be sure to explain to the customer 
what you are doing. 

When the reboot is complete, the Windows registry key causes the cus-
tomer’s Web browser to open automatically and load a unique eCare URL, 
which returns the customer to the trouble-ticket queue with the same ticket 
ID as before. 

When the customer first returns to the queue, the ticket status is shown in 
the ticket queue as Waiting to Reconnect to Agent, and the ticket is high-
lighted in your queue. (It is not highlighted for the other Support Agents in 
your organization. However, any Support Agent may select the ticket.) After a 
certain period of time, the highlighting is removed and the status changes to 
Waiting to Reconnect. 

3. When you accept the ticket, the screen-sharing window reopens. The full 
transcript from the previous session will appear. (The transcript is main-
tained even if another Support Agent accepts the trouble ticket, or if you 
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assist a reconnected customer who was previously assisted by another Sup-
port Agent.) 

4. Complete the eCare session and resolve it normally. 

The Messages, Push URL, and Reference Menus

The Messages Menu

When you chat with your customers, you may use the same phrases repeatedly. 
Your eCare administrator can add these phrases to the Messages menu, which 
displays a customized list of standard chat phrases you can select and send. See 
your eCare administrator for more information about this option.

The Push URL Menu 

The Push URL menu, which appears below the session transcript panel, provides 
a list of URLs that you may push to the customer’s Web browser. The URL you 
choose opens automatically in a new browser window on the remote computer. 

Depending on the type of difficulty the customer is having, you may wish to send 
URLs for technical support pages, links to download new or updated software, or 
sales information. Your eCare administrator can provide information about the 
URLs you may load.

To load a Web page on the customer’s computer, select a URL from the Push URL 
menu.  A new browser window opens on the remote computer with the specified 
URL loaded automatically. (Be sure to advise the customer that the new window 
may open behind the eCare session window.) 

Note: If the window fails to open, which may occur if the customer is using a pop-
up blocker, the customer may click the link that appears in the session transcript. 

You may wish to advise the user to bookmark the page for future reference.

The Reference Menu

The Reference menu, which appears below the session transcript panel, provides 
a list of URLs that you may load on your own computer. This list may include links 
to internal or external Web sites that contain information you can use to assist 
the customer. Your eCare administrator can provide information about the URLs 
you may load.
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To load a Web page on your computer, select a URL from the Reference menu. A 
new browser window opens on your computer with the specified URL loaded 
automatically.

Reestablishing an Interrupted Session

During an eCare session, it may occur that your connection with the customer 
fails. (For example, the customer’s network connection may be interrupted.) The 
eCare reconnect component allows eCare to retain the customer’s trouble-ticket 
number and session history when the customer reconnects. 

When you accept an eCare trouble ticket, and the eCare reconnect component is 
enabled on your eCare service, the Activate dialog box opens on the customer’s 
screen, asking them to activate the reconnect component. If the customer clicks 
Yes, eCare saves a unique URL as a shortcut on the customer’s desktop. If the 
eCare session is interrupted, the customer can double-click the shortcut to return 
to the trouble-ticket queue with the same ticket ID as before. 

If you are working with a customer and the session is interrupted, the session 
transcript will display the message “Lost network connection to customer name.” 
If the customer stops responding and you see this message, close the eCare ses-
sion window and return to the ticket queue. Depending on your organization’s 
policies, you may begin to assist another customer or wait to see if your customer 
will reconnect.

If the customer is able to reconnect, the trouble ticket will appear in the queue 
with the same ticket ID as before and the status Waiting to Reconnect to Agent. In 
addition, the ticket is highlighted in your queue. (It is not highlighted for the 
other Support Agents in your organization. However, any Support Agent may se-
lect the ticket.) After a certain period of time, the highlighting is removed and the 
status changes to Waiting to Reconnect. (Your eCare administrator will configure 
this timeout period when installing eCare.)

When you accept the trouble ticket, the screen-sharing window reopens. Proceed 
normally with the eCare session. The transcript area in the eCare session window 
will display the full session transcript, including the portion of the session that 
took place before the interruption.

Note: The customer can use the reconnection shortcut only one time, after which 
the URL is no longer valid. By default, the URL will expire after 50 minutes. Your 
eCare administrator can configure the expiration period.
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Ending a Support Session

When you help a customer, you have two options for ending your eCare session 
with that customer—you may resolve the trouble ticket or escalate it. 

It is important that you end your eCare session by resolving or escalating it, rather 
than closing your eCare session window. If you close the eCare session window 
without clicking Resolve or Escalate, eCare will assume that your Internet 
connection failed and that your customer still needs assistance. The customer’s 
trouble ticket will be returned to the queue with a status of Escalated.

Note: Your eCare administrator may configure your eCare service to display a sur-
vey when you resolve or escalate the trouble ticket. (See “Appendix B: Respond-
ing to eCare Surveys” on page 38.) Fill out the survey and click Submit to send the 
survey and return to the trouble-ticket queue. 

Resolving the Trouble Ticket

Once you have solved the customer’s problem and answered any remaining 
questions they may have, open the Ticket menu and choose Resolve.

Resolved trouble tickets are deleted from the queue. You are returned automati-
cally to the queue to accept another help request.

Escalating the Trouble Ticket

If you are unable to resolve the support issue for any reason, open the Ticket 
menu and choose Escalate to return the customer to the trouble-ticket queue. The 
escalated trouble ticket is highlighted in red and its status is changed to Esca-
lated. You may wish to escalate a ticket if a customer is having trouble outside or 
beyond your area of expertise.

Note: If your Internet connection fails while you are assisting a customer, eCare 
will detect that your eCare session terminated unexpectedly and the trouble 
ticket will be escalated automatically. Make sure to end each eCare session by 
choosing the Resolve or Escalate option.
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Service

The System Information service gathers targeted information on the operating en-
vironment of the remote computer, which may assist you in solving the remote 
user’s problem. For example, the service retrieves the remote computer’s operat-
ing system and a list of installed software, which may enable you to resolve con-
flicts or determine the likely cause of errors. In addition, you’ll receive a complete 
list of the processes running on the remote computer and a summary of Internet 
Explorer’s proxy and security settings. Erroneous settings are a common cause of 
connection failures. 

Note: This appendix covers the System Information report only for Windows 
computers. 

Generating the System Information Report

To generate a system report for the customer’s computer, open the Tools menu 
and choose System Information. 

When you start the System Information service, an Ask for Permission dialog box 
appears on the customer’s screen, requesting permission to examine the com-
puter. The customer must click Allow to enable the session to proceed.

Once the examination is complete, a new browser window opens and displays 
the System Information report. (This process may take a few moments.)
| 33
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The System Information window displays information in five categories: 

• General, which summarizes basic information about the user, operating sys-
tem, and hardware of the remote computer. See page 35.

• Installed Software, which provides a complete list of the registered software 
installed on the remote computer. See page 35.

• Internet, which provides a summary of the Internet Explorer setup on the re-
mote computer. See page 36.

• Processes, which provides a complete list of the processes running on the re-
mote computer. See page 36.

• Libraries, which provides a complete list of the libraries (DLL files) on the re-
mote computer and the specific version of each library. See page 36.
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Using the System Information Report 

General Information

The General tab summarizes basic information about the user, operating system, 
and hardware of the remote computer.

User Information

The User Information section summarizes the login status and Windows directory 
information for the remote computer.

The Administrator value may be particularly valuable if the remote user is having 
trouble installing software—if the user is not logged in as an Administrator, soft-
ware installations may not proceed successfully.

Machine Information

The Machine Information section summarizes the operating system and hard-
ware profile for the remote computer. Information includes the operating system, 
processor, and available memory on the remote computer.

The processor and available memory values may be particularly valuable if the re-
mote user is having difficulty with computer performance. Performance may be 
degraded if these values are low.

Installed Software Information

The Installed Software tab provides a complete list of the registered software in-
stalled on the remote computer. Select an application in the list to view its details 
at the bottom of the window. 

Note: The System Information service gathers this information from the Windows 
Registry. If the remote computer is running software that does not register itself in 
the Windows Registry, it will not appear in the Software Information profile.

The Installed Software tab allows you to view all the applications installed on a 
customer’s computer, enabling you to diagnose possible conflicts or absent 
software.
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Internet Information

The Internet tab provides a summary of the Internet Explorer setup on the remote 
computer. This category may help you determine whether any of the computer’s 
Internet Explorer security or proxy settings are conflicting with the eCare service 
or other applications. 

Processes Information

The Processes tab provides a complete list of the processes running on the re-
mote computer. This category allows you to identify all the tasks currently run-
ning on the remote computer, such as applications and background processes. 
Use this information to identify any problem or areas of incompatibility, or to de-
termine whether an application component is missing. 

Running Processes 

The Running Processes section provides a complete list of the processes running 
on the remote computer. Select a process to display its details in the Details for 
Process and Loaded Libraries sections. 

Details For [Process] 

The Details for [Process] section displays detailed information about the selected 
process.

Loaded Libraries

The Loaded Libraries section displays information about the DLL libraries associ-
ated with the selected process. This section appears only if the selected process 
has associated libraries. 

Libraries Information

The Libraries tab provides a complete list of the libraries (DLL files) on the remote 
computer and the specific version of each library. Use this information to identify 
any problem or areas of incompatibility that may occur if the remote computer is 
using the wrong version of a library file. 
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Closing the System Information Window

When you are finished with the System Information report, close the window by 
clicking the close button in the upper-right corner of the window. Or, when you re-
solve or escalate the trouble ticket, the window will close automatically. 

If your eCare Administrator has configured eCare to automatically save data from 
the System Information report, the raw XML on which the report is based is ar-
chived for audit and diagnostic purposes. To view the data (which will be dis-
played in raw XML format, without special processing), click the link in the 
session transcript line “The system analysis data can be seen by clicking here.” 
The customer may also use this link to view their computer’s data.

If you need to reopen the report in its original format, however—or if eCare is not 
configured to save reports and you need to review the report data—you must use 
the System Information service again.
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Appendix B: Responding to eCare Surveys

Your eCare administrator may configure your eCare service to display a survey 
when you resolve (or escalate) a trouble ticket or when you sign out of eCare. 

Your customers may also be presented with surveys after they fill out the ticket 
submission form or after you resolve their trouble ticket. 

Surveys are used to gather information about your customers and your eCare ex-
perience. They will help your administrator customize both eCare and your orga-
nization’s other customer-support methods, such as documentation, training, 
and call centers. 

When you encounter a survey, fill it out thoroughly. Then click Submit to send the 
survey and return to the trouble-ticket queue or finish signing out of eCare.



| 39

Appendix C: Troubleshooting

If you are having trouble using eCare, review the following issues for a resolution.

• You must have administrator privileges on your computer to install the eCare 
remote-control component. If you do not have administrator privileges, your 
eCare administrator will install the eCare remote-control component for you. 

• The customer also must have administrator privileges to install the eCare 
remote-control component, as well as the eCare reconnect component. If the 
customer does not have administrator privileges, you will be able to chat 
with the customer, but you will not be able to use screen-sharing services. 

• If you attempt to accept a trouble ticket, but the eCare session window does 
not open, make sure that all pop-up blocking software for your browser is 
turned off. This includes the pop-up blockers that are built in to Internet Ex-
plorer and Safari, as well as third-party blocking software for all platforms. 

• When you open an eCare session with a remote computer, the actions you 
may perform depend on the service privileges that have been assigned to 
your Support Agent account. For example, if you are using an account with 
“standard agent” privileges, all of the screen-sharing features are disabled. 
To use screen-sharing services, you must have “premium agent” privileges. 
Contact your eCare administrator if you believe your service privileges are 
incorrect.

• If the Remote Tasks tab in the eCare session window is missing or empty, 
make sure that both you and your customer are using a supported Web 
browser. See “System Requirements” on page 5 for a list of supported brows-
ers and their associated settings. 

• If you are using Safari and you are repeatedly prompted to install the eCare 
plugin, restart Safari. You must perform the restart to complete the plugin 
installation.
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